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Overview 

Blockly for PICAXE is a free powerful visual programming tool for generating PICAXE microcontroller 
programs. By stacking coloured blocks on top of each other a control program can be rapidly 
generated. This simple click’n’drag programming method allows students to rapidly develop control 
sequences for real life microcontroller projects. 

Blockly can be run in a web browser on almost any device that has an internet connection. For 
offline use Blockly is embedded within PICAXE Editor and is also available as a standalone Chrome 
app. 

 
Blockly can be used in 3 different ways: 
 
1) Within PE6 (PICAXE Editor 6) which is the main PICAXE programming environment (Windows) 
2) As a standalone app (Windows/Mac/Linux/Chromebook) 
3) On the www.picaxecloud.com website (any browser) 
 
All 3 methods share exactly the same Blockly source code and so work in a similar way on all 
platforms. However PE6 does contain a more powerful simulation engine. 
 
 
The wide range of PICAXE specific blocks allows the user to control output devices, such as motors 
and LEDs that are connected to the PICAXE microcontroller.  We can switch devices on or off in 
sequences using: timing, counting, repetition, and decisions based on signals from digital and 
analogue sensors that are connected to the PICAXE microcontroller. 
 
This section of the manual explains how the most common blocks are used, giving examples of the 
common blocks and techniques in the context of possible school projects.  
 

 
Quick Start 
 
If you are unfamiliar with the program approach to building control systems, it is a good idea to 
begin by familiarising yourself with the most commonly used blocks, which are: Outputs, Wait, 
Motor and Inputs.  
 

 

http://www.picaxecloud.com/
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1. How to build, edit and test run a program 

 
2. Outputs 
This section shows: how to switch output devices and motors connected to outputs of a PICAXE 
microcontroller, using Outputs, Motor, Sound and Play blocks; how the Serout block can be used to 
output serial information from the PICAXE microcontroller. 
 

3. Inputs 
This section shows: how to check the state of digital sensors connected to a PICAXE microcontroller 
using the input block; how to use the Interrupt block for instant response to digital sensors; how to 
use the variable decision block to make use of readings from analogue sensors connected to a 
PICAXE microcontroller, in a control system. 
 

4. Delays 
This section shows: how to created delays using pause and sleep 
 

5. Procedures 
This section shows the important technique of building a control system as a number of linked sub 
systems. 
 

6. Maths & Variables 
This section shows: how to create counting systems using Increase and Decrease blocks; how timing 
can be built into a control system; how Expressions and Random blocks are used to give a value to a 
variable; how Read and Write blocks are used to store and access values of variables using the 
PICAXE microcontroller’s EEPROM memory. 
 

7. Advanced Blocks 
This section shows: how to use some of the more advanced PICAXE command blocks. 
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Section 1. How to build, edit and simulate in Blockly 

PE6  - Click the ‘New Blockly’ ribbon button. 
App - Click Project > New 
Web - Login and then click Project>New 
 
The Blockly screen looks similar to: 
 

 

     

Workspace - This is the right hand area where your program is created 

 

Toolbox - This is the collection of available blocks to drag onto the stage 

 

Simulation Panel – 

This displays the animated simulation when the program is run ‘on-screen’, In PE6 

the Simulation Panel looks slightly different, but performs the same task.   

 

Language – 

Blockly has been translated into a number of different languages. Click on the 

currently selected top right (e.g. ‘English’) to select a new language.  
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Selecting the correct PICAXE type 

Before the progam is created the correct PICAXE microcontroller chip type and download cable COM 

port should be selected.  

PE6 – Use the Workspace Explorer    App – Use the Settings menu 

     

 

Note that if you have the wrong PICAXE chip selected the available input/output pins displayed in 

the block drop-down lists will not be accurate.  

If you do not see a Port called ‘AXE027 PICAXE USB’ make sure that the AXE027 download cable is 

correctly inserted and the driver (if required) has also been installed. For further details on how to 

do this see www.picaxe.com/axe027 

 

 

 

http://www.picaxe.com/axe027
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NOTE: This section deals only with drawing 
the program. Details of how to use the 
individual blocks are given later. 
 

Adding a new block 
Drag the required block from the toolbox and 
place it on the workspace.  Most blocks have a 
drop down list of options that are used to 
alter the way the block operates. 
 

 
Some other blocks have a ‘jigsaw piece’ input 
position where another block can be dropped, 
for instance you may drop a constant 
(number) or a variable into this block. 
 

 
 
If a block is missing the ‘!’ icon and warning 
may be shown, this warning will automatically 
disappear when the block is inserted. 
 
Loops and decision blocks also allow other 
blocks to be stacked inside them e.g. 
 

 
 
 

Start block 

A Start block marks the point where the 
program starts running.  
 

 
 
When the PICAXE microcontroller is reset or 
powered up, the program starts at the first 
Start block. Every program must have at least 
one Start block. A program will stop running 
whenever a Stop block is reached. 
 
For PICAXE-M2 parts you can have up to 8 
Start blocks on each program. New Start 
blocks are found in the ‘Tasks’ toolbox 
section. 

 

 
 
 



 

  Blockly Manual © Revolution Education Ltd 2002-2016 v1.2.0   May be copied for educational use.  7 

Moving blocks 
To move a single block or a stack of blocks, 
select the top block and drag it to its new 
position. 
 

Zooming & Deleting 

 
At the bottom right hand side of 
the Blockly screen are 4 icons: 
 
1) Zoom to 100% at centre 
 
2) Zoom In 
 
3) Zoom Out 
 
4) Delete 
 
 

 
To delete a block either  
1) drag it into the ‘trash can’ 
2) press the Delete key on the keyboard 
3) right click and select ‘Delete Block’ 
 
Note that as all programs need a Start block 
the first start block cannot be deleted. 
 

Cutting, Copying and Pasting 
Use the Cut, Copy and Paste options from the 
Edit menu to cut or copy selected blocks or 
stack of blocks and paste them either into 
another part of the same program or into a 
different program.  
 
Alternatively, you can right click and select 
‘Duplicate Blocks’ 
 

Grid 
The grid can be hidden or displayed via the 
Blockly Settings. When the grid is displayed 
blocks automatically ‘snap’ to the nearest grid 
point. 
 
 
 
 
 
 
 

Comment Blocks 
It can be useful to drop comments onto your 
program to tell other people how it functions. 
Comment blocks are found in the ‘Advanced’ 
section. 

 

 
 
Labelling a block 
It can be useful to give a block an internal 
comment which identifies what it is used for, 
e.g. “switch LED on”. To add a comment right 
click over the block and select ‘Add Comment’ 
 

 
 
A new ‘?’ icon will then appear, when you 
click the icon the comment will be displayed 
and can be edited. 
 
The block comment does not affect the 
operation of a block; they are only a label for 
‘humans’ to read. 
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Renaming Inputs and Outputs 
It can be useful to rename an Input or Output 
pin to remember what it is used for. To do this 
either right click over a block and select 
‘Input/Output Table’ or select this item from 
the main ‘Settings’ menu. 

 
 
Names for all the inputs and outputs can then 
be entered.  
 

 
 
 
 
 
 
 
 
 

After entering the names they will be saved in 
the Blockly file and will appear in the pin 
selection drop-down menu on all blocks. 

 
 
To delete a label simply change the label back 
as its default value (e.g. B.0) in the 
Input/Ouput Table. 



 

  Blockly Manual © Revolution Education Ltd 2002-2016 v1.2.0   May be copied for educational use.  9 

How to test run a program 
 
Before you download a program to a PICAXE 
microcontroller, it is useful to be able to check 
that it works as you intend it to. Simulation 
has a number of features that allow you to 
test run the program in the software. 
 

1. The Simulation Panel 
As a program runs, the Digital Panel shows 
the changing state of outputs and inputs as 
they would be if the program had been 
downloaded to a PICAXE microcontroller. 
                                         

   

 
2. Simulating digital inputs 
To change the state of an input simply click on 
the input in the simulation panel. It will turn 
from grey (off) to yellow (on). 
 
 

 
 
 
 
 
 
 
 
 
 
 

3. Simulating analogue inputs 
 
To change the value of an analogue input 
right click on the input pin to display the 
radial slider. Turn the slider as required. 
 

 
         
4. Run and Stop 
To test run a program click the Run button on 
the toolbar or press <Ctrl>+<F5> 
 
To stop a program running click the Stop icon. 
 
As the program runs, the flow of control is 
highlighted so that you can follow it. If you 
want to slow down the speed at which flow is 
highlighted is controlled by the simulation 
delay slider. 
 

5. Breakpoints  
Right click on a block to add a breakpoint flag 
to it. When the simulation reaches this point 
the program will then pause. 
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6. Variables display 
If your program uses variables, it is useful to 
See the changing values of any of the 
variables that are used in the program will be 
displayed as the program runs.  
 
App – Variables appears under the simulation 
 

 
 
PE6 – Variables are shown in the Code 
Explorer 
 

 
 

7. Real Time Simulation 
If desired it is also possible to simulate a 
program on screen, but have ‘real-life’ inputs 
and outputs on the connected PICAXE chip 
interact with the simulation. This is called 
‘Real Time Simulation (RTS). 
 
When using RTS it is important to realise it is 
the computer, not the PICAXE chip, that is 
performing the processing. The PICAXE chip is 
just continuously sending the state of the 
connected inputs back up the download cable 
to the computer for processing. 
 

 
 
There are 3 steps to performing RTS: 
 
1) Connect the PICAXE chip via the download 
cable. Remember shared serial outputs (e.g. 
output C.0 on 08M2 or 14M2 chips) will be 
dedicated to RTS simulation communication. 
 
2) Click the Simulator > Download 
Communicator Program menu. This 
downloads the RTS ‘runtime’ program into 
the PICAXE chip. 
 
3) Click the Simulator > Connect menu. If all is 
well the on-screen LED will change from 
yellow to green and you can now start your 
‘connected’ simulation. 
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Downloading a program into a 
PICAXE chip 
 
PE6 and App (not Cloud) 
 
1. Connect your PICAXE project to the 
computer by the AXE027 USB download 
cable. 
2. Connect power to the PICAXE circuit board, 
normally 3 x AA  batteries (4.5V). 
3. Note; your PICAXE chip, if already 
programmed, may start running the program 
from its memory – this will not affect the 
programming process. 
4. Click the Program button on the PICAXE 
toolbar or press <F5>. 
5. The programming progress window will 
appear.  
6. Programming times vary depending on the 
type of chip and amount of program code – 
the larger the program, the longer the 
programming time. 
7. If successful, programming is complete 
when the progress bar disappears. 
 
If you are having difficulty programming try 
the hard reset procedure as described in part 
1 of the PICAXE manual. 
 
 

Cloud Only (not PE6 or App) 
 
Web browsers do not allow web sites to 
access the USB port of your computer. This is 
a very sensible security restriction. 
 
Therefore the online Cloud version of Blockly 
cannot program your chip directly (in the 
same way the app and PE6 versions can).  
 
Therefore the Cloud version instead saves 
onto your computer an ‘.axe file’ which is a 
compiled version of your PICAXE program.  
 
You must then use the Chrome Programmer 
App (www.picaxe.,com/progapp) to download 
the .axe file onto the PICAXE chip. 
 
 
 

Using the Cloud Programmer App 
 

 
 
1. Connect your PICAXE project to the 
computer by the AXE027 USB download 
cable. 
2. Connect power to the PICAXE circuit board, 
normally 3 x AA  batteries (4.5V). 
3. Note; your PICAXE chip, if already 
programmed, may start running the program 
from its memory – this will not affect the 
programming process. 
4. Open the desired .axe file and select the 
correct COM port. 
5. Click the Program button 
6. The programming progress window will 
appear.  
7. Programming times vary depending on the 
type of chip and amount of program code – 
the larger the program, the longer the 
programming time. 
8. If successful, programming is complete 
when the progress bar disappears. 
 
If you are having difficulty programming try 
the hard reset procedure as described in part 
1 of the PICAXE manual. 
 

http://www.picaxe.,com/progapp
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Displaying and using BASIC 
Blockly is also able to convert any complete 
program into BASIC or Javascript. 
 
BASIC is a text based language that is used 
throughout the world to program everything 
from PICAXE microcontrollers to personal 
computers. 
 
Javascript is a very common programming 
language used for developing web sites. 
 

Why Convert? 
Although Blocks are easy to understand and 
quick to build. BASIC programming languages 
offer more complexity to advanced level users 
and the ability to covert a program into BASIC 
offers a way of learning how BASIC programs 
are written. 
 

Converting a program into BASIC 
1. Design your program as normal and test the 
program using the program simulation tools. 
       
2. Convert to PICAXE BASIC 
 
App - Click on the ‘BASIC’ tab 
PE6 – Click on the ‘Convert To BASIC’ button  
 
3 The BASIC text window is then displayed 
containing the conversion of your program. 
 
Note that it is also possible to display the 
BASIC tab in PE6, to do this use the 
File>Options>Diagnostics>Blockly>’Display 
BASIC’ setting. 
 
 
 
 

 
 
 
Notes: 
Only blocks that are connected to Start block 
in your program are converted. 
 
It is not possible to convert from BASIC 
backwards to blocks. 
 
Using the BASIC block you can add sections of 
BASIC code into a program.  
 
For full information on the use of BASIC to 
program PICAXE chips see the PICAXE website 
at www.picaxe.com 
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Section 2. Outputs 
 
Turn output on/off block 

 

 
The turn output blocks are used to switch a 
single output on or off. 
 

 
Note that you can rename outputs if desired – 
see the Input/Output Table section earlier in 
this manual for more details. 
 

 
 
 
 
 
 
 
 
 

Pause block 
 

 
 
A pause block makes a running program 
pause for the number of milliseconds 
specified before the next block is carried out. 
You can use it to keep output devices 
switched on or off for a set time. Use its input 
box to enter a number of milliseconds or a 
Variable. 
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SPE035 MP3 Player Block 
 

 
 
The SPE035 MP3 Player is a low cost device 
that can be used to add music and speech into 
your PICAXE project. 
 

 
 
www.picaxe.com/products/spe035 
 
This block allows simple control of the SPE035 
module to easily play back MP3 tunes. 
 
 

             
 
 

 
 
 
 
 
 
 
 

Play Note Block 
 

 
 
Use a play note block to send a pulsed signal 
to a piezo sounder connected to an output of 
a PICAXE microcontroller. You can use a 
sequence of sound blocks to play a simple 
tune. 
 

             
 
Play block 
 

 
 
Most PICAXE chips have 4 pre-programmed 
internal tunes, which can be output via the 
Play block. 
 

As these tunes are often included within the 
PICAXE bootstrap code, they use very little 
program memory. 
 

The Tunes are: 
0 - Happy Birthday 
1 - Jingle Bells 
2 - Silent Night 
3 - Rudolf the Red Nosed Reindeer 
 

 

http://www.picaxe.com/products/spe035
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 Tune block 
 

 
 
Working in a similar way to the Play block, the 
Tune block allows special musical tunes to be 
played. 

 
The difference with Tune block is that it 
converts RTTTL mobile phone ringtone files to 
PICAXE tunes and plays them with or without 
flashing outputs. 
 
RTTTL ringtone files are freely available on the 
internet (there is a very wide range of tunes 
available) and these can be downloaded as 
small text files. The files contain the notes and 
timings that make up the tune. The Tune 
Wizard converts these ringtones to a PICAXE 
tune block upon download.  
 
Once you have downloaded your ringtone file 
(ensure it is an RTTTL format), save it to disk. 
 
In PE6 you can right click the Tune command 
to start the Wizard. For the App you will need 
to run the Wizard separately. 
 

 
 
 

Click the ‘Open RTTTL txt file’ button to 
browse the computer to find the file. 
 
Select the output to flash using the drop 
down box. The chosen outputs switch on/off 
in time to the tune. The Flash Mode can 
switch outputs 0 and 4. Ensure that you have 
configured the I/O pin 4 as an output using 
the Select PICAXE dialog in order to see all of 
the available options. 
 
Once you have generated the Tune BASIC click 
‘Copy’ in the Wizard so that you can the paste 
to code back into the Tune block. 
 
 
Note that, unlike the Play Block, the 
Tune block requires much more memory in 
the chip as all of the notes have to be 
specially programmed into the chip. If you 
wish to play your tune a number of times, use 
the Tune block in a Procedure to save 
memory. 
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Servo Block 
 

 
 
Servos, as commonly found in radio control 
toys, are a very accurate motor/gearbox 
assembly that can be repeatedly moved to 
the same position due to their internal 
position sensor. Generally servos require a 
pulse of 0.75 to 2.25ms every 20ms, and this 
pulse must be constantly repeated every 
20ms. Once the pulse is lost the servo will lose 
its position. 
 
The Servo block starts a pin pulsing high for 
length of time pulse (x0.01 ms) every 20ms.  
This block is different to all other blocks in 
that the pulsing mode continues until another 
servo block or outputs block. Outputs blocks 
stop the pulsing immediately. Servo blocks 
adjust the pulse length to the new pulse 
value, hence moving the servo. 
 
The block details for the servo block have two 
settings; the output pin that the servo motor 
is connected to and the pulse time. 
The pulse time can be a value held in a 
Variable. Note that the value for the pulse 
time MUST be in the range 75 to 225. The 
servo motor may malfunction if the pulse is 
outside of this range. 
                  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Example 
The program below will move a servo motor 
attached to output B.2 from one extent of its 
travel to the other, repeating continually.  
 
                    

 
                    Using the Servo block 
 
Note that the servo block is required to 
‘activate’ the servo pulsing. Once pulsing is 
started smoother operation (less jitter) can be 
achieved by using the ‘servopos’ command 
for subsequent movements. 
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Send Infrared block 
 

 
 
This block is used to transmit the infrared 
data to a Sony™ protocol device. It can also be 
used to transmit data to another PICAXE 
circuit that is using the ‘read infrared’ block. 
Data is transmitted via an infrared LED 
(connected on output 0) using the SIRC (Sony 
Infrared Control) protocol. 
                
The send infrared block can be used to 
transmit any of the valid TV data codes (0-
127). Note that the Sony protocol only uses 7 
bits for data, so data codes of value 128 to 
255 are not valid. 
 
See also the ‘read  infrared’ block. 
 

Pwmout  block 
 

 
 
The pwmout block is used to provide a varying 
ratio pulsed output. This is often used for 
speed control of motors. See the main PICAXE 
manual for more details. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Set Pins block 

 
 
When program flow passes through a ‘set 
pins’ block, the output port is set to the binary 
value of the number entered in the block. 
 
If you are familiar with the binary system then 
the set pins block is a convenient way of 
switching combinations of outputs on or off. 
 

 
 
In the table above  the ‘bits’ can be switched 
on by sending the selection value of the bit., 
e.g. ‘set pinsB to 4, which will turn on an LED 
at B.2 (and switch off all the other ouputs. 
 
 

Set Dirs block 
 

 
 
The set dirs. Block converts pins to either 
input or outputs. A binary bit value of 1 
means output, a value of 0 means input. 
 
Commands such as ‘turn output on’ will also 
automatically set the dirs bit to an output. 
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Motor blocks 
 

 
 
The Motor block allows you to use pairs of 
outputs on a PICAXE microcontroller to switch 
a motor forward, reverse or off. 
 
The motors are given a letter A to D that 
controls outputs as follows: 
 
 Non-8 pin 08M2 
A  (B.0, B.1) (C.0, C.1) 
B  (B.2, B.3)  (C.2, C.4) 
C  (B.4, B.5) 
D  (B.6, B.7) 
 
Remember that the direction in which a 
motor turns depends on which way current 
flows through it, and therefore on the way it 
is connected to power. Therefore if your 
motor moves in the wrong direction it may be 
necessary to reverse the two wires.  
              
NOTE: Output and Motor blocks both use the 
same output pins to switch the outputs of a 
PICAXE microcontroller.  
 
 
 
 
 
 
 
 
 
 

 
 
Example 
A steerable buggy is usually driven by two 
motors, one powering each driving wheel 
with a free-running jockey wheel to keep it 
stable. The program below  shows how a 
sequence of Motor blocks can be used to 
drive a buggy which has one motor connected 
to outputs 0 and 1 (motor A) and the other 
motor connected to outputs 2 and 3 (motor 
B).  
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Robot Motor blocks (various) 
 

 
Some robots such as the BOT120 Microbot  
use ‘pairs’ of motors (Motors C and D) to 
control their movement.  
 
For these robots it is easier to use the 
dedicated robot motor blocks, as these blocks 
will automatically control both of the robot’s 
motors at the same time.  
 
For instance to make the robot go forwards 
click the centre button in the top row. This 
will switch on both motors C and D in the 
‘forward’ direction 
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LCD blocks 
 

 
 
These block can be used to display a message 
on an LCD screen attached to a PICAXE-driven 
circuit board.    
 

 
www.picaxe.com/products/axe133y 
 
This block will be simulated if the program is 
simulated within PE6 (not within app). 
 
Within PE6 a small LCD screen window will 
pop up during the run to display the LCD 
message (make sure the simulation pin for the 
LCD is correctly set under 
File>Options>Simulation) 
 

 
          

 
                       Simulated LCD screen 
 
 

 

Serout Block 

 
This block allows output information to be 
sent from the PICAXE microcontroller to a 
device such as a serial printer, a serial LCD 
screen or another PICAXE which is connected 
to an output of a PICAXE microcontroller. 
 
The first list to set is the serial mode. Set the 
mode to that specified by the device you are 
sending data to. 
                
The second list is used to select the output pin 
on the PICAXE microcontroller to send the 
data through.  
 

 
 
The data to be sent is attached to the input on 
the right. This can be a text string, a variable, 
or a constant. 
 
If using a string make sure you also check 
‘send as ASCII’.  
If using a variable or constant you can either 
send the raw binary value e.g 32 (no ASCII 
check) or the ASCII character equivalents e.g. 
“3” then ”2”(check ASCII box) 

 
Sertxd Block 

 
The sertxd block is similar to the serout block, 
but acts via the serial output pin rather than a 
general output pin. This allows data to be sent 
back to the computer via the programming 
cable. This can be useful whilst debugging. 
 
See the PICAXE Manual 2 for more 
information 
 

http://www.picaxe.com/products/axe133y
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Section 3. Delays 
 
Pause block 
 

 
 
A pause block makes a running program 
pause for the number of milliseconds 
specified before the next block is carried out. 
You can use it to keep output devices 
switched on or off for a set time. Use its input 
box to enter a number of milliseconds or a 
variable. 
 

 
 
Wait until Input block 
 

 
 
This block waits until an input pin changes 
state – until the input goes on (high) or off 
(low). 
 
 
 
 
 
 

Sleep block 

 
 
This block puts the PICAXE microcontroller 
into low power mode for a specified number 
of seconds. 
 
This block can be used to save battery power 
in your project. All output devices will be left 
in their current condition, but signals from 
input devices will not be responded to while 
the chip is in sleep mode. 
 
The time input box is used to set the number 
of seconds of sleep mode required. 
 
Note that Sleep times are not as accurate as 
Pause times. 
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Section 4. Inputs 
 
Input devices such as switches and sensors 
send information from the outside world into 
the control system. Output devices are 
switched on or off in response to the 
information provided by input devices. 
 
Example 
A buggy is often fitted with micro-switches so 
that if it approaches an obstacle, a 
microswitch will be pressed.   

   
The information that the switch has been 
pressed can be used in the system to switch 
off the motors driving the buggy, and start a 
sequence of movements to move around the 
obstacle. 
 

A microswitch is a digital sensor. It has only 
two states - “on” (or “closed”) and “off” (or 
“open”). 
These states are often labelled by the digits 1 
and 0, which is why the sensors are called 
digital sensors. 
 
 
 
 
 
 
 
 
 
 
 

 
Example 
A controlled hot water system includes a 
temperature sensor which constantly 
monitors the water temperature. 
 
The water heater is switched on and off in 
response to the information provided by the 
sensor. If the water temperature falls below a 
set level, the heater is switched on until it 
reaches that level again. Then the heater is 
switched off. 

   
 
 
A temperature sensor is an analogue sensor. 
It provides a reading which changes in line 
with the changing level of whatever it is 
sensing. 
 

   
 
 
 
 
 
 
 
 
 
 
 
 
 



 

  Blockly Manual © Revolution Education Ltd 2002-2016 v1.2.0   May be copied for educational use.  23 

Input block 

 

 
 

Use this block to test the state of a digital 
sensor connected to a digital input of a 
PICAXE microcontroller. 
 
When program flow reaches the input block it 
will only process one of the two sections, 
dependant on whether the input pin is on 
(high) or off (low). 
 
Multiple input blocks can also be nested to 
test, for instance, if two pins are both on. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Analogue Block 
Temperature Block 
Ultrasonic Block 
 

 
 
These three blocks all operate in the same 
way, loading an analogue value into the select 
variable. To then test whether the desired 
threshold point has been reached a variable 
decision block is then used. 
 
Analogue – any generic sensor like an LDR 
Temperature – DS18B20 temperature sensor 
Ultrasonic – SRF005 distance sensor 
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Simulating a Digital Input 
 
To change the state of an input simply click on 
the input pin within the simulation. It will turn 
from grey (off) to yellow (on). 

 

 
 

Simulating an Analogue Value 
 
To simulate a changing value for analogue 
blocks right click over the corresponding pin 
in the simulation panel and use the radial 
slider. 
 

  
 
 
 
 
 

Calibrating a Sensor using Debug 

 
Often when using analogue sensors it is 
necessary to experiment to find the correct 
threshold point (e.g. the correct light value to 
switch a device on or off). 
 
To read analogue values ‘live’ from a PICAXE 
chip we can also use the Debug block in a loop 
like in the program below. 
  

 
 

Click on ‘Debug’ (in PICAXE menu in app or on 
the Code Explorer panel in PE6).  
 
The value of varA then be displayed on the 
computer screen and will update every 500 
millsseconds. 
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Read Infrared Block 
 

 
 
To receive information from an Infrared 
source, the Read Infrared block is used. The 
block will wait for a new infrared signal from 
an infrared TV style transmitter. It can also be 
used to receive a ‘send infrared’ block sent 
out from a separate PICAXE chip. 
 
All processing stops until the new block is 
received. The value of the code received is 
placed in the chosen variable. 
 
As TV style remotes (e.g. part TVR010) send 
out an offset value (e.g. value 0 for channel 1, 
value 1 for channel 2) the checkbox allows 
you to automatically add 1 to the value 
received, so the variable value then matches 
the button pressed. 
                  
 
The basic circuit required for this block is as 
follows. The device on the left side of the 
circuit is an IR receiver LED, part code LED020. 
 

         
 
 
 
 
 
 
 
 
 
 
 
 
 

Example 

 

In the following program a signal is received 
from a TV Infrared remote control. Lights are 
switched on if key 1 or key 2 is pressed. 
 

 
 
The read infrared block waits until a signal is 
received, and saves this as a number in 
Variable A. 
 
If the value is 1 or 2 the outputs are switched 
on. Otherwise the lights are switched off. 
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Interrupt Block 

 

 
 
An Interrupt instantly captures the flow of 
control whenever a preset digital input 
condition occurs to trigger it e.g. when a 
switch is pressed. 
 
When the interrupt is triggered flow jumps 
immediately to a sub-procedure block (which 
must be called ‘interrupt’) and then carries 
out any blocks which follow until it reaches 
the end of that block. It then returns to the 
point in the main program which it was at 
when the Interrupt occurred. 
 
In order to use an Interrupt, the PICAXE must 
be told to look for the input condition. This is 
done through the enable interrupt block. 
 

 
 
To prevent the Interrupt retriggering itself, 
the Interrupt is automatically disabled once it 
is triggered. To re-enable it another enable 
interrupt block is required. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Example 

 

A PICAXE microcontroller running a 
continuous loop flashing lights needs to be 
able to react to a button press and play a 
warning sound. 
 

 
The Interrupt is used to capture the flow and 
play a sound. The interrupt is then enabled 
once again before returning to the point at 
which it left the main flow. 
 
There is no limit to the number of blocks 
inside the Interrupt. It is a common technique 
to add an ‘Enable Interrupt’ block just before 
the end of the procedure, so that when the 
Interrupt sub procedure returns the interrupt 
is re-enabled. 
 
Only one Interrupt sub-procedure can be used 
per program. 
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Serial In Block 

 

 
 
The Serial In block is used to receive serial 
data into an input pin of the microcontroller. 
It cannot be used with the serial download 
input pin, for this pin use the serrxd command 
instead. 
 
The input pin is the input on the PICAXE that 
the data is to be received through. The 
Variable option is a variable location that the 
data is stored into once it is received. 
 
The first option specifies the baud rate and 
polarity of the signal. When using simple 
resistor interface, use N (inverted) signals. 
When using a MAX232 type interface use T 
(true) signals. The protocol is fixed at N,8,1 
(no parity, 8 data bits, 1 stop bit). 
 
The Serial In block forces the PICAXE chip to 
wait until serial data is received through the 
chosen input. This data is stored in the chosen 
variable. 
 
To store raw binary data (as opposed to ASCII 
strings) make sure the ASCII checkbox is not 
checked. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Example 

 

Serial data is being received from another 
PICAXE chip and needs to be stored in the 
EEPROM. 
In the program shown below, the serial data is 
read into Variable B through input pin C.2. 
The Write block is used to store the value in 
Variable B in the EEPROM. This process is 
repeated 16 times to fill the EEPROM memory 
locations  
 
                      

 
      Using the SerIal In block to receive serial data 
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Section 5. Procedures 

 

Blockly provides a clear, step-by- step method 
of building a complex control system, by 
creating a number of linked subsystems called 
“sub procedures”. 
 
 

How to build a sub procedure 
 

 
Drag out a ‘to do Procedure’ block to begin 
the procedure. Drag the block onto the 
program and place it separately from the 
start block as shown below.  
 
Change the name to something related to the 
task it does. 
 

 
 
Use other blocks as normal to create the 
procedure. 
 

 
 
 

 
 
 
 
 
 
 

How to use a procedure 
Once you have built a procedure, you can call 
it into use whenever you like in the program 
by using the call block, as shown below. 
    
       

 
 
The call  block calls the procedure into use. 

 

 
 
Drag the call block onto the program. Place it 
at the point where you want the procedure to 
be called into use.  
 
Note that all the procedures that have been 
built in a program are automatically listed in 
the toolbox. When flow reaches a call block, it 
jumps to the Procedure block with the same 
name. When the program flow reaches the 
end of the procedure, the flow jumps back to 
the call block that called the procedure. To 
test run the whole program click on the 
simulation Run button. 
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Example 

 

A PICAXE microcontroller is used to control a 
system in a child’s toy which plays a tune 
when it is hugged. A piezo transducer is 
connected to an output pin, and a push switch 
is used to sense when the toy is hugged. The 
program for the system is shown below. The 
tune is created as a procedure which can be 
tested and edited separately from the main 
routine.  
 

                    
 

 
 
Using a Procedure to play a tune after an input condition 
is met 
 
 
 
 
 
 
 
 
 
 
 
 
 

Example 
 

              

The program shown below is a control system 
for a sliding door. When a switch is pressed, 
the door opens. It stays open for ten seconds 
and then closes again.  
 
 

 
 
Sliding door control system using procedures 
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Section 6. Maths & Variables 

 

In Blockly a variable is a ‘number container’ 
that can hold a given value between 0-65535.  
 
The variables are called varA to varZ by 
default, but can be renamed to any name you 
choose. To rename a variable simply click on 
the drop down arrow to the right of the name 
and select ‘Rename Variable…’ 
 

 
 
This section explains how they can be used for 
a variety of mainly counting and timing 
purposes. 
 
The current value of a variable can be seen 
during a simulation in the Code Explorer panel 
(PE6) or under the simulation panel (app). 
 
 

 
 

 
 

Increase Variable block 

 
 
Each time flow passes through an Increase 
block, the desired value is added to the value 
of the selected variable. 
 
 

Decrease Variable block 

 
 
The decrease block works in a very similar 
way to the increase block.  
 
The difference is that when program flow 
passes through a decrease block, the value is 
subtracted from the selected variable. 
 
Note that PICAXE chips do not support 
negative numbers, so any number below 0 
will underflow e.g. -1 actually becomes 65535. 
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 Variable If block 
 

 
 
To test the variable the ‘variable if’ block is 
used. The value can be tested to see if it is 
greater, less than or equal to another variable 
or a set value. 
 
This block is unique in that its shape can be 
modified to add more tests. To do this click 
the blue ‘settings’ icon top left and then, 
working completely within the small pop-up 
window, configure the block by dragging out 
the number of else if commands required.  
 

 
 
 
 
 
 
 
 
 

Example one  
Using this system you can configure the 
blocks for a number of consecutive tests, as 
shown in this infrared example. 
 

 
 
 
Example two 
A PICAXE microcontroller is being used to 
control a lamp. A light sensor is connected to 
analogue input 0. The system will switch on 
the lamp automatically in dark conditions. 
Below is a program for the system. 
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Example three 
 

A PICAXE microcontroller is used to control a 
system for counting cars entering and leaving 
a car park using two digital sensors. When 10 
cars are in the car park the ‘FULL’ light is lit. 

 
 
 
                      

 
 
 

 
 
 
 
 
     Program for making and displaying a count. 
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Set Variable block 
 

 
 
A value can also be given to a variable in the 
form of a mathematical expression as shown 
in the example above (varA = varC + varB). 
 
Note how multiple expressions can also be 
nested inside each other to make the 
equation longer (varA =  varC + varB + 10). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Random block 

 
 
Using the random block a variable can be 
given a random value between 0 and 65535. 
In the example shown below, a set of display 
lights for a small Christmas tree are connected 
to 8 outputs of a PICAXE microcontroller. 
Every second the display will change at 
random.  
 

              
 

Note that as with all microcontrollers and 
computers, the generation of random 
numbers is based on a sequence. 

                  



 

  Blockly Manual © Revolution Education Ltd 2002-2016 v1.2.0   May be copied for educational use.  34 

Section 7. Advanced Blocks 
 
Read and Write Blocks 
 

 
When a program run is started, all variable 
values automatically reset to zero. So, when 
the PICAXE microcontroller is reset or 
powered up, all variable values are reset to 
zero. 
 
If you want to retain variable values when the 
PICAXE microcontroller is powered up or 
reset, you can use the write block to store 
values in the chip’s data EEPROM memory. 
The read block is used to retrieve the values 
from the chip’s memory.  
 
The read block takes the value which is 
currently stored in a selected address (in this 
case address 0), and puts it into the selected 
variable (in this case variable A).  
 
The PICAXE microcontroller’s data EEPROM 
memory has 255 separate addresses. Each 
address can store a number between 0 and 
255. The EEPROM window (PE6 only) displays 
the contents of the memory when you test 
run a program.  
 
                    

 
                         Data EEPROM window 

 
 
 

Read I2C and Write I2C Blocks 
 

 
 
The I2C commands allow communication with 
third party devices such as memory EEPROMs 
and sensors. For further details see the main 
PICAXE manuals. 
 

 
BASIC 
 

 
 
This block is used as an extension to a 
program. Any valid PICAXE BASIC code can be 
typed into the block cell window. When 
program flow arrives at this block the BASIC 
code within the block will be processed as if it 
were a procedure. 
 
Note that only PE6 can simulate the BASIC 
code, the app/cloud versions of Blockly will 
skip over this block. This is because PE6 
contains a much more powerful simulator 
engine than the web versions. 
 
   
 
 
 
 
 
 
For information on the other advanced 
commands (e.g. suspend, reconnect etc.) 
please see the corresponding description in 
PICAXE manual 2 (BASIC commands).  
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Section 8. Licenses 
 
‘Blockly for PICAXE’ makes use of the following open source projects and gratefully acknowledges the  
hard work of the developers of these projects. 
 
Blockly  https://github.com/google/blockly/blob/master/COPYING 

Bootstrap https://github.com/twbs/bootstrap/blob/master/LICENSE 
FileSaver https://github.com/eligrey/FileSaver.js/blob/master/LICENSE.md 
Blob  https://github.com/eligrey/Blob.js/blob/master/LICENSE.md 
CodeMirror https://github.com/codemirror/CodeMirror/blob/master/LICENSE 
JS-Interpreter https://github.com/NeilFraser/JS-Interpreter/blob/master/LICENSE 

Acorn  https://github.com/ternjs/acorn/blob/master/LICENSE 

jQuery  https://github.com/jquery/jquery/blob/master/LICENSE.txt 
Mustache.js https://github.com/janl/mustache.js/blob/master/LICENSE 

RequireJS https://github.com/jrburke/requirejs/blob/master/LICENSE 
Signals  https://github.com/millermedeiros/js-signals 
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http://getbootstrap.com/
https://github.com/eligrey/FileSaver.js
https://github.com/eligrey/Blob.js/
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https://github.com/NeilFraser/JS-Interpreter
https://github.com/marijnh/acorn
https://github.com/jquery/jquery
https://github.com/janl/mustache.js
https://github.com/jrburke/requirejs
https://github.com/millermedeiros/js-signals

